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Chapter 241 

Equivalence Tests for the 
Ratio of Two Proportions 
in a Cluster-Randomized 
Design 
Introduction 
This module provides power analysis and sample size calculation for equivalence tests of the ratio in two-sample, 
cluster-randomized designs in which the outcome is binary.  

Technical Details 
Our formulation comes from Donner and Klar (2000). Denote a binary observation by where g = 1 or 2 is the 
group, k = 1, 2, …,  is a cluster within group g, and m = 1, 2, …,  is an individual in cluster k of group g. The 
results that follow assume an equal number of individuals per cluster. When the number of subjects from cluster to 
cluster are about the same, the power and sample size values should be fairly accurate. In these cases, the average 
number of subjects per cluster can be used.  

The statistical hypothesis that is tested concerns the ratio of the two group proportions,  and . When 
necessary, we assume that group 1 is the treatment group and group 2 is the control group. With a simple 
modification, all of the large-sample sample size formulas that are listed in the module for testing superiority by a 
margin with two proportions using the ratio can be used here.  

When the individual subjects are randomly assigned to one of the two groups, the variance of the sample 
proportion is 

 

When the randomization is by clusters of subjects, the variance of the sample proportion is 
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The factor  is called the inflation factor. The Greek letter  is used to represent the intracluster 

correlation coefficient (ICC). This correlation may be thought of as the simple correlation between any two subjects 
within the same cluster. If we stipulate that  is positive, it may also be interpreted as the proportion of total 
variability that is attributable to differences between clusters. This value is critical to the sample size calculation. 

The asymptotic formula for the Farrington and Manning Likelihood Score Test that was used in comparing two 
proportions (see Chapter 214, “Equivalence Tests for the Ratio of Two Proportions”) may be used with cluster-
randomized designs as well, as long as an adjustment is made for the inflation factor. 

Power Calculations 
A large sample approximation may be used that is most accurate when the values of n1  and n2  are large. The 
large approximation is made by replacing the values of p1  and p2  in the z statistic with the corresponding values 
of p1  and p2  under the alternative hypothesis, and then computing the results based on the normal distribution.  

Note that in this case, exact calculations are not possible. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design and Options 
tabs. For more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and 
power.   

Solve For 

Solve For 
This option specifies the parameter to be solved for using the other parameters. The parameters that may be 
selected are Power, Sample Size (K1), Sample Size (M1), Effect Size, and ICC. Under most situations, you will 
select either Power or Sample Size (K1). 

Select Sample Size (K1) when you want to calculate the number of clusters per group needed to achieve a given 
power and alpha level. 

Select Power when you want to calculate the power of an experiment.  

Test 

Test Type 
The Likelihood Score Test (Farrington & Manning) is the only test available for this procedure. 

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected.  
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Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size – Group 1 (Treatment) 

K1 (Clusters in Group 1) 
Enter a value (or range of values) for the number of clusters in this group. You may enter a range of values such 
as 10 to 20 by 2. The sample size for this group is equal to the number of clusters times the number of subjects per 
cluster. 

M1 (Items per Cluster in Group 1) 
This is the average number of items (subjects) per cluster in group one. This value must be a positive number that 
is at least 1. You can use a list of values such as 100 150 200. 

Sample Size – Group 2 (Reference) 

K2 (Clusters in Group 2) 
This is the number of clusters in group two. The sample size for this group is equal to the number of clusters times 
the number of subjects per cluster. This value must be a positive number.  

If you simply want a multiple of the value for group one, you would enter the multiple followed by K1, with no 
blanks. If you want to use K1 directly, you do not have to pre-multiply by 1. For example, all of the following are 
valid entries: 10 K1 2K1 0.5K1. 

You can use a list of values such as 10 20 30 or K1 2K1 3K1. 

M2 (Items per Cluster in Group 2) 
This is the number of items (subjects) per cluster in group two. This value must be a positive number.  

If you simply want a multiple of the value for group one, you would enter the multiple followed by M1, with no 
blanks. If you want to use M1 directly, you do not have to pre-multiply by 1. For example, all of the following are 
valid entries: 10  M1 2M1 0.5M1. 

You can use a list of values such as 10 20 30 or M1 2M1 3M1. 

Effect Size – Equivalence Ratios (P1.0/P2) 

R0.U & R0.L (Upper & Lower Equivalence Ratio) 
Specify the margin of equivalence by specifying the largest ratio (P1/P2) above (R0.U), and below (R0.L), which 
will still result in the conclusion of equivalence. As long as the actual ratio is between these two values, the 
difference between the proportions is not said to be large enough to be of practical importance.  

The values of R0.U must be greater than 1 and the values of R0.L must be less than 1. R0.L can be set to 
‘1/R0.U’, which is most often desired. 
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The power calculations assume that P1.0 is the value of the P1 under the null hypothesis. This value is used with 
P2 to calculate the value of P1.0 using the formula: P1.0U = R0.U x P2. 

You may enter a range of values for R0.U such as 1.1 1.5 1.8 or 1.1 to 2.1 by 0.2. 

Note that if you enter values for R0.L (other than ‘1/R0.U’), they are used in pairs with the values of R0.U. Thus, 
the first values of R0.U and R0.L are used together, then the second values of each are used, and so on.   

R0.L must be between 0 and 1. R0.U must be greater than 1. Neither can take on the value 1.  

Effect Size – Actual Ratio (P1.1/P2) 

R1 (Actual Ratio) 
This option specifies the ratio of P1.1 and P2, where P1.1 is the actual proportion in the treatment group. The 
power calculations assume that P1.1 is the actual value of the proportion in group 1. This difference is used with 
P2 to calculate the value of P1 using the formula: P1.1 = R1 x P2. In equivalence trials, this ratio is often set to 1. 

Ratios must be positive. You may enter a range of values such as 0.95 1 1.05 or 0.9 to 1.9 by 0.02.  

Effect Size – Group 2 (Reference) 

P2 (Group 2 Proportion) 
Specify the value of P2, the control, baseline, or standard group’s proportion. The null hypothesis is that the two 
proportions differ by a specified amount (See Specify Group 1 Proportion using below).  

Since P2 is a proportion, these values must be between 0 and 1. 

You may enter a range of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1. 

Effect Size – Intracluster Correlation 

ICC (Intracluster Correlation) 
Enter a value (or range of values) for the intracluster correlation. This correlation may be thought of as the simple 
correlation between any two observations in the same cluster. It may also be thought of as the proportion of total 
variance in the observations that can be attributed to difference between clusters. 

Although the actual range for this value is from 0 to 1, typical values range from 0.002 to 0.05. 
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Example 1 – Finding Power 
A study is being designed to establish the equivalence of a new treatment compared to the current treatment. 
Historically, the standard treatment has enjoyed a 60% cure rate. The new treatment reduces the seriousness of 
certain side effects that occur with the standard treatment. Thus, the new treatment will be adopted even if it is 
slightly less effective than the standard treatment. The researchers will recommend adoption of the new treatment 
if the rate ratio of treatment to control is between 0.75 and 1.25.  

The researchers will recruit patients from various hospitals. All patients at a particular hospital will receive the 
same treatment. They anticipate enlisting an average of 50 patients per hospital. Based on similar studies, they 
estimate the intracluster correlation to be 0.002. 

The researchers plan to use the Farrington and Manning likelihood score test statistic to analyze the data. They 
want to study the power of the two, one-sided tests proposed by Farrington and Manning when the number of 
clusters per groups ranges from 2 to 10. They want to investigate the behavior of this test when the actual cure 
rate of the new treatment ranges from 60% to 66% (rate ratio = 1.0 to 1.1). The significance level will be 0.05. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Equivalence Tests for the Ratio of Two Proportions in a Cluster-Randomized Design 
procedure window by expanding Proportions, then Two Proportions – Cluster Randomized, then clicking on 
Equivalence, and then clicking on Equivalence Tests for the Ratio of Two Proportions in a Cluster-
Randomized Design. You may then make the appropriate entries as listed below, or open Example 1 by going to 
the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Test Type ................................................ Likelihood Score (Farr. & Mann.) 
Alpha ....................................................... 0.05 
K1 (Clusters in Group 1) ......................... 2 4 6 8 10 
M1 (Items per Cluster in Group 1) .......... 50 
K2 (Clusters in Group 2) ......................... K1 
M2 (Items per Cluster in Group 2) .......... M1 
R0.U (Upper Equivalence Ratio) ............ 1.25 
R0.L (Lower Equivalence Ratio) ............. 0.75 
R1 (Actual Ratio) .................................... 1.0 1.05 1.1 
P2 (Group 2 Proportion) ......................... 0.6 
ICC (Intracluster Correlation) .................. 0.002 
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Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Equivalence Tests for the Ratio of Two Proportions (Cluster-Randomized) 
Test Statistic: Likelihood Score Test (Farrington & Manning) 
H0: P1/P2 ≤ R0.L or P1/P2 ≥ R0.U.   H1: R0.L < P1/P2 = R1 < R0.U. 
 
                                 Grp 1  Grp 1             
        Group 1   Group 2       Lower  Upper  Grp 1 Lower Upper  Intra-  
      Clusters/ Clusters/ Grp 2 Equiv. Equiv. Actual Equiv. Equiv. Actual Cluster  
          Items     Items  Prop   Prop   Prop   Prop Ratio Ratio Ratio Corr.  
Power     K1/M1     K2/M2    P2  P1.0L  P1.0U   P1.1 R0.L R0.U R1 ICC Alpha 
0.32704 2/50 2/50 0.6000 0.4500 0.7500 0.6000 0.750 1.250 1.000 0.0020 0.050 
0.77694 4/50 4/50 0.6000 0.4500 0.7500 0.6000 0.750 1.250 1.000 0.0020 0.050 
0.92712 6/50 6/50 0.6000 0.4500 0.7500 0.6000 0.750 1.250 1.000 0.0020 0.050 
0.97630 8/50 8/50 0.6000 0.4500 0.7500 0.6000 0.750 1.250 1.000 0.0020 0.050 
0.99240 10/50 10/50 0.6000 0.4500 0.7500 0.6000 0.750 1.250 1.000 0.0020 0.050 
0.31030 2/50 2/50 0.6000 0.4500 0.7500 0.6300 0.750 1.250 1.050 0.0020 0.050 
0.65767 4/50 4/50 0.6000 0.4500 0.7500 0.6300 0.750 1.250 1.050 0.0020 0.050 
0.81499 6/50 6/50 0.6000 0.4500 0.7500 0.6300 0.750 1.250 1.050 0.0020 0.050 
0.90181 8/50 8/50 0.6000 0.4500 0.7500 0.6300 0.750 1.250 1.050 0.0020 0.050 
0.94937 10/50 10/50 0.6000 0.4500 0.7500 0.6300 0.750 1.250 1.050 0.0020 0.050 
0.24921 2/50 2/50 0.6000 0.4500 0.7500 0.6600 0.750 1.250 1.100 0.0020 0.050 
0.46869 4/50 4/50 0.6000 0.4500 0.7500 0.6600 0.750 1.250 1.100 0.0020 0.050 
0.60903 6/50 6/50 0.6000 0.4500 0.7500 0.6600 0.750 1.250 1.100 0.0020 0.050 
0.71705 8/50 8/50 0.6000 0.4500 0.7500 0.6600 0.750 1.250 1.100 0.0020 0.050 
0.79842 10/50 10/50 0.6000 0.4500 0.7500 0.6600 0.750 1.250 1.100 0.0020 0.050 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
K1 and K2 are the number of clusters in groups 1 and 2, respectively. 
M1 and M2 are the average number of items (subjects) per cluster in groups 1 and 2, respectively. 
P2 is the proportion for group 2. This is the standard, reference, baseline, or control group. 
P1.0L is the smallest proportion for group 1 (treatment group) that still results in the conclusion of 
   equivalence. 
P1.0U is the largest proportion for group 1 (treatment group) that still results in the conclusion of 
   equivalence. 
R0.L = P1.0L/P2 is the smallest ratio that still results in the conclusion of equivalence. 
R0.U = P1.0U/P2 is the largest ratio that still results in the conclusion of equivalence. 
R1 = P1.1/P2 is the actual ratio at which the power is calculated. 
ICC is the intracluster correlation. 
Alpha is the probability of rejecting a true null hypothesis. 
 
Summary Statements 
Sample sizes of 100 in group 1 and 100 in group 2, which were obtained by sampling 2 clusters 
with 50 subjects each in group 1 and 2 clusters with 50 subjects each in group 2, achieve 
32.704% power to detect equivalence. The margin of equivalence, given in terms of the ratio of 
the proportions, extends from 0.750 to 1.250. The actual ratio of the proportions is 1.000. The 
group 2 proportion is 0.6000. The calculations assume that two, one-sided Likelihood Score 
Tests (Farrington & Manning) were used. The intracluster correlation is 0.0020, and the 
significance level of the test is 0.050. 
 

This report shows the values of each of the parameters, one scenario per row. The total number of items sampled 
in group 1 is N1 = K1 x M1. The total number of items sampled in group 2 is N2 = K2 x M2. 
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Plots Section 
 

  
 

     
 

The values from the table are displayed on the above charts. These charts give a quick look at the sample size that 
will be required for various values of R1. 
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Example 2 – Finding the Sample Size (Number of Clusters) 
Continuing with the scenario given in Example 1, the researchers want to determine the number of clusters 
necessary for each value of R1 when the target power is set to 0.80.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Equivalence Tests for the Ratio of Two Proportions in a Cluster-Randomized Design 
procedure window by expanding Proportions, then Two Proportions – Cluster Randomized, then clicking on 
Equivalence, and then clicking on Equivalence Tests for the Ratio of Two Proportions in a Cluster-
Randomized Design. You may then make the appropriate entries as listed below, or open Example 2 by going to 
the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size (K1) 
Test Type ................................................ Likelihood Score (Farr. & Mann.) 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
M1 (Items per Cluster in Group 1) .......... 50 
K2 (Clusters in Group 2) ......................... K1 
M2 (Items per Cluster in Group 2) .......... M1 
R0.U (Upper Equivalence Ratio) ............ 1.25 
R0.L (Lower Equivalence Ratio) ............. 0.75 
R1 (Actual Ratio) .................................... 1.0 1.05 1.1 
P2 (Group 2 Proportion) ......................... 0.6 
ICC (Intracluster Correlation) .................. 0.002 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Equivalence Tests for the Ratio of Two Proportions (Cluster-Randomized) 
Test Statistic: Likelihood Score Test (Farrington & Manning) 
H0: P1/P2 ≤ R0.L or P1/P2 ≥ R0.U.   H1: R0.L < P1/P2 = R1 < R0.U. 
 
                                 Grp 1  Grp 1             
        Group 1   Group 2       Lower  Upper  Grp 1 Lower Upper  Intra-  
      Clusters/ Clusters/ Grp 2 Equiv. Equiv. Actual Equiv. Equiv. Actual Cluster  
          Items     Items  Prop   Prop   Prop   Prop Ratio Ratio Ratio Corr.  
Power     K1/M1     K2/M2    P2  P1.0L  P1.0U   P1.1 R0.L R0.U R1 ICC Alpha 
0.87247 5/50 5/50 0.6000 0.4500 0.7500 0.6000 0.750 1.250 1.000 0.0020 0.050 
0.81499 6/50 6/50 0.6000 0.4500 0.7500 0.6300 0.750 1.250 1.050 0.0020 0.050 
0.83073 11/50 11/50 0.6000 0.4500 0.7500 0.6600 0.750 1.250 1.100 0.0020 0.050 
 

The required sample size depends a great deal on the value of R1. The researchers should spend time determining 
the most appropriate value for R1.  
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Example 3 – Finding Sample Size (Individuals within Clusters) 
Continuing with the scenario given in Example 2, the researchers want to determine the number of individuals 
that they’ll need to recruit in each hospital if they can enroll only 5 hospitals vs 10 in each group for each value of 
R1 when the target power is set to 0.80.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Equivalence Tests for the Ratio of Two Proportions in a Cluster-Randomized Design 
procedure window by expanding Proportions, then Two Proportions – Cluster Randomized, then clicking on 
Equivalence, and then clicking on Equivalence Tests for the Ratio of Two Proportions in a Cluster-
Randomized Design. You may then make the appropriate entries as listed below, or open Example 3 by going to 
the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size (M1) 
Test Type ................................................ Likelihood Score (Farr. & Mann.) 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
K1 (Clusters in Group 1) ......................... 5 10 
K2 (Clusters in Group 2) ......................... K1 
M2 (Items per Cluster in Group 2) .......... M1 
R0.U (Upper Equivalence Ratio) ............ 1.25 
R0.L (Lower Equivalence Ratio) ............. 0.75 
R1 (Actual Ratio) .................................... 1.0 1.05 1.1 
P2 (Group 2 Proportion) ......................... 0.6 
ICC (Intracluster Correlation) .................. 0.002 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for Equivalence Tests for the Ratio of Two Proportions (Cluster-Randomized) 
Test Statistic: Likelihood Score Test (Farrington & Manning) 
H0: P1/P2 ≤ R0.L or P1/P2 ≥ R0.U.   H1: R0.L < P1/P2 = R1 < R0.U. 
 
                                 Grp 1  Grp 1             
        Group 1   Group 2       Lower  Upper  Grp 1 Lower Upper  Intra-  
      Clusters/ Clusters/ Grp 2 Equiv. Equiv. Actual Equiv. Equiv. Actual Cluster  
          Items     Items  Prop   Prop   Prop   Prop Ratio Ratio Ratio Corr.  
Power     K1/M1     K2/M2    P2  P1.0L  P1.0U   P1.1 R0.L R0.U R1 ICC Alpha 
0.80732 5/42 5/42 0.6000 0.4500 0.7500 0.6000 0.750 1.250 1.000 0.0020 0.050 
0.80397 10/20 10/20 0.6000 0.4500 0.7500 0.6000 0.750 1.250 1.000 0.0020 0.050 
0.80349 5/59 5/59 0.6000 0.4500 0.7500 0.6300 0.750 1.250 1.050 0.0020 0.050 
0.80523 10/28 10/28 0.6000 0.4500 0.7500 0.6300 0.750 1.250 1.050 0.0020 0.050 
0.80063 5/112 5/112 0.6000 0.4500 0.7500 0.6600 0.750 1.250 1.100 0.0020 0.050 
0.80466 10/51 10/51 0.6000 0.4500 0.7500 0.6600 0.750 1.250 1.100 0.0020 0.050 

 
If they can enroll 10 hospitals, then they need to recruit between 20 and 51 patients at each, depending on the 
actual cure rate ratio. If they can only enroll 5 hospitals, then they’ll need to recruit many more patients… 
between 42 and 112.  
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Example 4 – Validation 
We could not find an example of this type of analysis in the literature. Therefore, we will validate the procedure 
by comparing the results to those computed by the “Equivalence Tests for the Ratio of Two Proportions” 
procedure since both should give identical results for the same sample sizes when the ICC is set to zero. We ran 
the case when N1 = N2 = 200, P2 = 0.6, R0.U = 1.2, R0.L = 1/R0.U, R1 = 1, and Alpha = 0.05. In this procedure, 
set M1 = 1 and set K1 = 200. The Equivalence Tests for the Ratio of Two Proportions procedure calculates the 
power to be 0.43259 for the Likelihood Score (Farrington & Manning) test.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Equivalence Tests for the Ratio of Two Proportions in a Cluster-Randomized Design 
procedure window by expanding Proportions, then Two Proportions – Cluster Randomized, then clicking on 
Equivalence, and then clicking on Equivalence Tests for the Ratio of Two Proportions in a Cluster-
Randomized Design. You may then make the appropriate entries as listed below, or open Example 4 by going to 
the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Test Type ................................................ Likelihood Score (Farr. & Mann.) 
Alpha ....................................................... 0.05 
K1 (Clusters in Group 1) ......................... 200 
M1 (Items per Cluster in Group 1) .......... 1 
K2 (Clusters in Group 2) ......................... K1 
M2 (Items per Cluster in Group 2) .......... M1 
R0.U (Upper Equivalence Ratio) ............ 1.2 
R0.L (Lower Equivalence Ratio) ............. 1/R0.U 
R1 (Actual Ratio) .................................... 1.0 
P2 (Group 2 Proportion) ......................... 0.6 
ICC (Intracluster Correlation) .................. 0.0 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for Equivalence Tests for the Ratio of Two Proportions (Cluster-Randomized) 
Test Statistic: Likelihood Score Test (Farrington & Manning) 
H0: P1/P2 ≤ R0.L or P1/P2 ≥ R0.U.   H1: R0.L < P1/P2 = R1 < R0.U. 
 
                                 Grp 1  Grp 1             
        Group 1   Group 2       Lower  Upper  Grp 1 Lower Upper  Intra-  
      Clusters/ Clusters/ Grp 2 Equiv. Equiv. Actual Equiv. Equiv. Actual Cluster  
          Items     Items  Prop   Prop   Prop   Prop Ratio Ratio Ratio Corr.  
Power     K1/M1     K2/M2    P2  P1.0L  P1.0U   P1.1 R0.L R0.U R1 ICC Alpha 
0.43259 200/1 200/1 0.6000 0.5000 0.7200 0.6000 0.833 1.200 1.000 0.0000 0.050 
 

The power computed by this procedure is also 0.43259 when ICC = 0.  
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